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With Dimo Video Converter Ultimate, you can easily rip and copy Blu-ray/DVD disc, ISO and folder, download movies

from YouTube, Vimeo, Facebook, BBC, etc, convert video/audio files to optimum format for personal use in iPhone, iPad,

Android, VR, TV, game consoles, editors, etc., edit, play, share media contents to devices and make ISO, 3D/VR video,

create GIF by following the guide with steps below.

Guide Index

Part 1: Trial Version vs. Full Version

DimoVideo Converter Ultimate is available both in paid and trial version.

Trial Version Limitations:

Downloader limit: For the trial version users, you have one chance to download video from the internet.

Playing limit: There is a image watermark from Dimo that is added to your source Blu-ray/DVD for previewing with the trial version.

Ripping limit:For the trial version users, the length of converted video file from Blu-ray/DVD is limited. You can only convert 1/3rd of the

disc with the trial version.

Conversion limit: For the trial version users, the length of converted video file from transcoding and compressing is limited. You can only

convert 1/3rd of the video with the trial version.

ISOMaking limit: Users can make ISO from folder or Blu-ray with only 3 times with the trial version.

No technical support provided: For trial version users, no technical support is provided.

Full Version Benefits:

With full version of DimoVideo Converter Ultimate, you will enjoy the complete benefits include:

No downloader limit: You can download video from the internet by anytime.

No playing limit: You can preview any Blu-ray/DVDwith no watermark limitation.

No ripping limit: You can rip any Blu-ray/DVDwith no length limitation.

No converting limit: You can convert any SD/HD/4K video with no length limitation.

https://www.mediadimo.com/images/guide/trial.jpg


No ISOMaking limit: There is no limit on the number of times that you can make ISO.

Complete technical support: You will get the complete technical support and upgrade fromDimo for lifetime.

Part 2: User-interface

DimoVideo Converter Ultimate: Get Started

Download

Download online movies

With DimoVideo Converter Ultimate, you can fast download YouTube videos and other videos from 300+ online video sites like Vimeo,

Facebook, BBC, etc. Also, this online downloader can work as an video converter, player, editor, media server as well. In this case, you are

capable of searching videos from YouTube and other sites, playing online videos smoothly, downloading videos at high speed,

convert/edit or share the downloaded videos in line with your needs, even make ISO files.

Step 1. Locate online videos

Take YouTube as an example. Go to youtube.com, log in with your user account, find an animated movie and copy (Ctrl + C) the video

URL.

Step 2. Set the folder for downloading

Click "..." by the end of the interface to appoint the "Save to" folder on your computer to save the downloaded files;

Step 3. Open the "Download" tab, paste video URL (Ctrl + V) in the address box. And click the "+" button to start downloading the

movie/film/video from YouTube.

https://www.mediadimo.com/wp-content/uploads/2017/07/start.png


Once the online movies in 720p/1080p/2160pMP4 are downloaded, click "Open" to locate your downloaded movies for offline watching

without barriers.

Convert

Rip Blu-ray/DVD

Why do you need to rip Blu-ray/DVD? If you have some favorite Blu-ray/DVDmovies and want to play them on your iPhone, Android

phone, VR, TV, etc., the first thing you need to do is to digitize Blu-ray/DVD to be supported by your device. Get video off a Blu-ray/DVD

into another digital format is quite easy through Dimo Video Converter Ultimate! Now start to rip Blu-ray/DVDmovies into the desired

format:

Step 1: Launch DimoVideo Converter Ultimate

Download, install and open Dimo Video Converter Ultimate.

Step 2: Import Blu-ray/DVD

The next step is to import inserted Blu-ray/DVD from Blu-ray drive or DVD-ROM and make the appropriate settings.

https://www.mediadimo.com/digitize-blu-ray.html
https://www.mediadimo.com/backup-dvd-game-of-thrones-to-digital.html


Step 3. Load Blu-ray/DVD to Software

To load DVDmovies, you can click "Add DVD" icon at the top of the interface. As for Blu-ray discs, please turn to "Add Blu-ray".

Tip: Before ripping your Blu-ray or DVD discs, you can backup them at first.

For example, you can copy Blu-ray disc to BDMV folder or make ISO from Blu-ray.

https://www.mediadimo.com/wp-content/uploads/2016/10/insert-dvd.png
https://www.mediadimo.com/images/dvd/wmp-format.jpg
https://www.mediadimo.com/copy-bluray-bdmv-folder.html
https://www.mediadimo.com/create-iso-from-blu-ray.html


Or copy Blu-ray/DVDmain titles.

Also, you can click "Copy DVDDisc to Folder" tomake DVD backup to Video_ts folder.

https://www.mediadimo.com/copy-dvd-to-video-ts-folder.html


Then, you can choose desired audio track or subtitle for preservation in the converted files.

Step 4: Set output video format

Look at the right panel of the software. Click "Select Format" to choose desired output video and audio format. You also can choose some

optimized preset from "Device > Apple" profile to get most compatible format for devices like iPhone X/8/8 Plus/7/7 Plus below.

https://www.mediadimo.com/wp-content/uploads/2017/07/choose-audio-track-subtitle.png
https://www.mediadimo.com/iphone-supported-formats.html


Step 5: Edit Blu-ray/DVD (Optional)

You can edit Blu-ray/DVDmovies according to your need by clicking on "Edit" button. Then a new editing windowwill be opened from

where you can apply the required effects.

https://www.mediadimo.com/images/dvd/iphone-video-format.png


Step 6: Custom your own output video

To define a custom format, you can click on "Settings" button. This will open a new windowwhere you can choose your needed A/V

parameters and press "OK".

https://www.mediadimo.com/images/video/guide/trim.png


Step 7: Specify output folder

After all the above settings, the next step is to specify the output folder for the resultant file. You can either keep the default output

folder or specify another one according to your requirement by clicking "...".

Step 8: Start ripping Blu-ray/DVD to digital files

The last step is to hit on "Start" to begin to converting Blu-ray/DVDmovies to digital files you selected. The converting time relies on the

size of your Blu-ray/DVD.

Convert Recorded/Downloaded Video

The videos captured through phone/camcorder or downloaded from online have specific file formats which are not compatible with

many devices. Therefore tomake recordings or video downloads compatible with most of your devices, they must be converted to some

popular output format.With DimoVideo Converter Ultimate, the recorded or downloaded video can be easily re-encoded into any other

popular video format.

Step 1: Copy recorded/downloaded video to PC

Connect your phone/camcorder to PC Before start to convert recorded video, you need to connect your phone or camcorder where

stored the video to computer wit USB cable or wirelessly. Once you have connected your camcorder/phone to computer, you can now

export your recordings from camcorder/phone to PC. Save the exported video files at a known location in your computer. Or copy

downloadedmovies and videos to your PC.

https://www.mediadimo.com/images/dvd/iphone-format-settings.png


Step 2: Launch DimoVideo Converter Ultimate

When you have saved all recordings or video downloads on your computer, launch DimoVideo Converter Ultimate by double clicking the

installation file.

Step 3: Load videos to convert

After successfully launching Dimo Video Converter Ultimate, you are now expected to load video files in it. You can either using the

dragging method or "Add File" method to import recorded/downloaded video to this top video converter.

https://www.mediadimo.com/wp-content/uploads/2016/10/camera-to-pc.jpg
https://www.mediadimo.com/top-video-converter.html
https://www.mediadimo.com/images/video/dimo-windows.png


Step 4: Edit video (Optional)

If you have video editing need, you can use crisp editing features offered by Dimo Video Converter Ultimate to trim, deinterlace, crop,

rotate, add special effect, adjust saturation/brightness/contrast, add text watermark, create 3D, etc. Of course, you can skip this step

completely if you don't want any editing to be done.

Step 5: Choose output format

Themain goal if video conversion process is to change video format. DimoVideo Converter Ultimate supports more than hundreds of file

formats and you can choose any one from them according to your requirement. You can choose needed one from "Format", "Device",

"TV", etc. like TV supported formats from "Select Format" section in the right pane.

https://www.mediadimo.com/images/video/guide/crop.png
https://www.mediadimo.com/tv-supported-format.html


Step 6: Custom output format

DimoVideo Converter Ultimate also allows users to custom output video/audio parameters. You can custom define output format by

clicking "Settings" button and filling out the appropriate details.

Step 7: Define output folder

The next step is to specify output folder. By default, DimoVideo Converter Ultimate allocates a folder for all the resultant files. And you

can change the location of output folder according to your requirement.

Step 8: Start video conversion

When all the settings are done, you can start converting recorded/downloaded video file by clicking on "Start" button. The conversion

timewill depend upon the length of the video being converted.

https://www.mediadimo.com/images/video/sony-tv-video-format.png
https://www.mediadimo.com/images/video/sony-tv-video-settings.png


Convert to SD/HD/4K videos

High definition video brings us more detailed, lifelike and impressed images.Want to turn your normal SD videos to HD video? Or need

to downscale 4K to HD videos for playing smoothly? You can easily make that realized with Dimo Video Converter Ultimate.

Step 1: Launch DimoVideo Converter Ultimate.

The very first step is to install Dimo Video Converter Ultimate on computer. Then double click on installation file to launch it.

Step 2: Add video files to be converted.

Now, it is time to add video files you want to convert. You can simple drag and drop video files into the interface or click "Add File" button

located on the top, it will open a file explorer from where you can choose the video file for conversion.

Step 3: Choose SD/HD/4K video as output format.

After imported source video toDimo Video Converter Ultimate, open "Select Format" drop-down list to locate "Video" or "HD Video"

category under "Format" or "4K Video". You can choose any SD/HD/4K video format you want here.

https://www.mediadimo.com/4k-to-hd-converter.html
https://www.mediadimo.com/images/video/dimo-windows.png


Tips: By clicking "Settings" button, you can adjust the output video/audio resolution, frame rate, bit rate, etc. to customize the output files

to get the best quality you want.

Step 4: Specify output folder.

After all the settings is completed, define an output folder on your computer to save the generated files by clicking "...".

Step 5: Start conversion process.

Click "Start" button to start SD/HD/4K video conversion process. It will take a fewminutes (depending on file size) for the conversion to

complete. Once the conversion is completed, click on "Open" or "Open Folder" button to view the generated video file.

Convert to Audio

https://www.mediadimo.com/images/video/hd-video-converter.png
https://www.mediadimo.com/images/video/hd-mp4-settings.png


Want to extract your favorite music from a video clips or convert from one audio to another audio? You can never find a program that's

so simple to use than Dimo Video Converter Ultimate. Go ahead by following the steps below:

Step 1: Launch DimoVideo Converter Ultimate.

First install and launch DimoVideo Converter Ultimate on your computer.

Step 2: Add video or audio files to the program.

You can load video or audio files to the programwith twomethods: directly drag the files into interface or click on "Add File" button

located on the top, it will open a file explorer from where you can choose the video file for conversion.

Step 3: Choose the output format under "Format > Audio" category.

After loading files into the program with success, specify your favorite output audio format for the output video. Hit "Select Format" in

the right panel of the program, in the pop out window, click "Format" tab, under "Audio" sub tab, select your desired audio formats from

the available audio file lists.

https://www.mediadimo.com/images/video/dimo-windows.png


Tip: If the default video/parameters can't meet your needs, just click Settings icon to adjust the video codec, bitrate, frame rate, audio

sample rate, etc to get a decent video as you want. In principle, the larger input values, the better output quality, but the corresponding

larger file size.

Step 4: Specify output folder.

Once you have selected the output audio format, Then define an output folder on your computer to save the generated files. Leave

output folder to default if you don't want to change it to any other folder.

Step 5: Convert video/audio file to audio.

Go back to the main interface, click on the "Start" button to start the video to audio or audio to audio conversion process, it will take a

fewminutes (depending on file size) for the conversion to complete.When the conversion is completed, click on "Open" button to view

the generated audio file. You can enjoy extracted audio files or make ringtone for iPhone/Android for listening to.

https://www.mediadimo.com/images/video/mp3-format.png
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Convert toWebVideo

Sometimes, after creating a video by your own, you may want to share it with your friends, family or the world. The best way is to upload

them on video sharing sites like YouTube, Vimeo, Facebook, etc.. You can convert virtually any file format with the resolution of

4K/UHD/2K/HD/SD from one to YouTube/Vimeo/Facebook compatible format with Dimo Video Converter Ultimate with the steps

below:

Step 1: Launch DimoVideo Converter Ultimate.

First install and launch DimoVideo Converter Ultimate on your computer.

Step 2: Add video files to be converted.

You can load files to the programwith twomethods: directly drag the files into the interface or click on "Add File" button located on the

top, it will open a file explorer fromwhere you can choose the video file for conversion.

Step 3: Edit video (Optional).

When the video is loaded into the program, click the "Edit" icon under the video output information panel, you can do some simple and

basic video editing work such as trimming, croping, rotating, adjust saturation/brightness/contrast, adding text watermark, deinterlacing,

adding special effect, etc. according to your own needs. This step is optional and can be skipped if you do not need this step.

https://www.mediadimo.com/youtube-format.html
https://www.mediadimo.com/images/video/dimo-windows.png


Step 4: Choose the output format.

Once you have completed the video editing process, choose the outputWeb video format in the "Web" profile under "Format" from

"Select Format" section. There are multiple different video formats for you to choose from.

https://www.mediadimo.com/images/video/guide/effect.png


Step 5: Define your own output video

If you could not find your desired output format from the output formats list, you can create your own custom format by clicking on

"Settings" button as highlighted below. In the "Settings" window, choose the video/audio settings according to your requirement and

then click "OK".

Step 6: Specify output folder.

After all the settings is completed, define an output folder on your computer to save the generated files by clicking "...".

Step 7: Start the conversion process.

Click on "Start" button to start the video conversion process, it will take a fewminutes (depending on file size) to complete.When the

conversion is completed, click on "Open" or "Open Folder" button to view the generated video file.

https://www.mediadimo.com/images/video/youtube-format.png
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Convert to Editors

At present, most video editting software like Sony Vegas, Adobe Premiere Pro,WindowsMovieMaker, etc. can allow you to edit your

videos imported from various DVs of ARRI AMIRA camera, Panasonic AVC or P2 cameras, Sony, Cannon etc. before publishing or sharing

with your friends.

But unfortunately those editors can't support all file formats, such as, Premiere Pro can import these container files ofMOV, AVI, MXF,

and F4V, but the ability to import the data that they contain is dependent on the codecs (specifically, decoders) installed. Sometimes, it

will take a rather boring long pending time for importing theMXF or other files to an editor. So, in this case, You can convert virtually any

file format with the resolution of 4K/UHD/2K/HD/SD from one to another with Dimo Video Converter Ultimate with the steps below:

Step 1: Launch DimoVideo Converter Ultimate.

First install and launch DimoVideo Converter Ultimate on your computer.

Step 2: Add video files to be converted.

You can load files to the programwith twomethods: directly drag the files into the interface or click on "Add File" button located on the

top, it will open a file explorer fromwhere you can choose the video file for conversion.

Step 3: Edit Video(Optional).

When the video is loaded into the program, click the "Edit" icon under the video output information panel, you can do some simple and

basic video editing work such as trimming, croping, rotating, adjust saturation/brightness/contrast, adding text watermark, deinterlacing,

adding special effect, etc according to your own needs. This step is optional and can be skipped if you do not need this step.

https://www.mediadimo.com/edit-mxf-in-windows-movie-maker.html
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Step 4: Choose the output format.

Once you have completed the video editing process, choose the output Editor video format in the "Editor" profile from "Select Format"

section. There are multiple different video formats for you to choose from.

https://www.mediadimo.com/images/video/guide/watermark.png


Step 5: Define your own output video

If you could not find your desired output format from the output formats list, you can create your own custom format by clicking on

"Settings" button as highlighted below. In the "Settings" window, choose the video/audio settings according to your requirement and

then click "OK".

Step 6: Specify output folder.

After all the settings is completed, define an output folder on your computer to save the generated files.

Step 7: Start the conversion process.

Click on "Start" button to start the video conversion process, it will take a fewminutes (depending on file size) to complete.When the

conversion is completed, click on "Open" or "Open Folder" button to view the generated video file.

https://www.mediadimo.com/images/video/sony-vegas-format.png
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Convert toMulti-track

You can remux virtually any file format with the resolution of 4K/UHD/2K/HD/SD or rip Blu-ray/DVD to lossless mkvwith the same

codec as the original one in fast mode, and convert media files to multi-trackMP4/MKVwith Dimo Video Converter Ultimate with the

steps below:

Step 1: Launch DimoVideo Converter Ultimate.

First install and launch DimoVideo Converter Ultimate on your computer.

Step 2: Add video files to be converted.

You can load files to the programwith twomethods: directly drag the files into the interface or click on "Add File", "Add Blu-ray" or "Add

DVD" button located on the top, it will open a file explorer from where you can choose the video file for conversion.

Tip: You can edit loaded video files via the internal video editor by clicking "Edit" before conversion.

Tip: To convert video or rip Blu-ray/DVD tomulti-track MKVwith selected audio tracks or subtitles, please click "Multi-trackMKV" and

choose your desired audio channel/subtitle. Then click "Convert > Start" to begin creaing a customized multi-track MKV file.

Step 3: Choose the output format.

Choose the output format in the right panel for your video, here you need to choose Lossless MKV orMulti-trackMP4 from "Format >

Multi-track".

https://www.mediadimo.com/lossless-blu-ray-to-mkv-backup.html
https://www.mediadimo.com/copy-dvd-to-lossless-mkv.html
https://www.mediadimo.com/images/video/dimo-windows.png


Note: The "fast mode" option is checked by default now if you select lossless mkv format. And you don't need to do any format settings

since fast mode is activated when remuxing your videos.

Step 4: Specify output folder.

Define an output folder on your computer to save the generated files.

Step 5: Start the conversion process.

Click on "Start" button to start the video conversion process, it will take a fewminutes (depending on file size) for the conversion to

complete.When the conversion is completed, click on "Open" or "Open Folder" button to view the generated video file.

Convert to Apple/Samsung/LG/Android

https://www.mediadimo.com/images/video/lossless-mkv.png
https://www.mediadimo.com/images/video/lossless-mkv-settings.png


Want to enrich your newly purchased iPhone, iPad, iPod, Samsung, LG, Android, etc. with all your favorite online downloadedmovies for

watching on the move?While, it is really a great headache that your mobile devices can only playback just few format files. Don't worry.

With DimoVideo Converter Ultimate, you can easily get any video to be played on the move with the optimal profile settings.

Step 1: Download, install and launch Dimo Video Converter Ultimate.

Double click installation file on your computer to launch it.

Step 2: Import source file to the program.

It is pretty easily to load files with Dimo Video Converter Ultimate, you can directly drag and drop the files to the program or use "Add

File" button to load source files.

Step 3: Select the desired output format from the "Device" option.

To make the output video to be compatible with your Apple/Samsung/LG/Android, hit "Select Format" in the right panel, in the pop out

window, click "Device" tab, choose "Apple", "Samsung", "LG", "Android", "Sony", "HTC", etc. in the sub tab, then you will be able you select

your specific device model from the available devices list.

https://www.mediadimo.com/images/video/dimo-windows.png


Tip: If the default settings do not fit you requirement, you can click "Settings" icon to adjust video size, bit rate, frame rate, sample rate

and audio channels.

Step 4: Choose output folder.

After you have chosen your device from the "Select Format" list, the next step is to find a location to store the converted files. You can

select the output folder according to your own preference.

Step 5: Start to convert video to Apple/Samsung/LG/Android.

After above settings is done, hit right-bottom "Start" button to start converting loaded files to device optimized file formats. The

conversion time will be highly dependent on the file size of the video file.

Step 6: Transfer Video to devices.

When the conversion is complete, you can find the generated video file in output folder specified. Connect your mobile phone to your

computer and then transfer the video file to iPhone/iPad via iTunes, or share to Android either through USB orWi-Fi.

Convert to TVs

Nowadays it is convenient to put movies on USB flash drive and play them on your TV via USB port. What happens is that the TV can't

either read the video files sometimes or the images are kind of distorted with poor audio. Since codec support is likely to be limited to

whatever Panasonic/Samsung/Sony/LG decided to support in their TV. Unfortunately the video's you play on the TV will need to be

formatted in such a way that they are encoded using codecs supported by the TV. Fortunately, with DimoVideo Converter Ultimate, you

can easily get TV compatible file format from virtually any file formats.

Step 1: Launch DimoVideo Converter Ultimate.

Double click Dimo Video Converter Ultimate icon on your computer to launch it.

Step 2: Import source file to the program.

https://www.mediadimo.com/images/video/android-format.png
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It is pretty easily to load files with Dimo Video Converter Ultimate, you can directly drag and drop the files to the program or use the

"Add File" button to load source files.

Step 3: Select TV preset format under the "TV" option.

To make the output video to be compatible with your Panasonic/Samsung/Sony/LG TV, hit "Select Format" in the right panel, in the pop

out window, click "Device" tab and choose formats under "TV" option.

Tip: Click the "Settings" button and customize proper video/audio parameters if necessary. Video size, bitrate and fame rate are flexible

and can be adjusted as you like.

https://www.mediadimo.com/images/video/dimo-windows.png
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Step 4: Choose output folder.

After you have set the output format for TV, the next step is to find a location to store the converted files. You can select the output

folder according to your own preference.

Step 5: Start to convert video to Panasonic/Samsung/Sony/LG TV.

After above settings is done, hit right-bottom "Start" button to start converting loaded files to TV optimized file formats. The conversion

timewill be highly dependent on the file size of the video file. When the conversion is complete, you can find the generated video file in

the output folder specified. And you can transfer all the output files to a USB drive and then play them on TV either through USB orWi-Fi.

Convert to GameConsoles

We can use Xbox 360, XboxOne (S), PS3, PS4 (Pro), PS Vita, PSP,Wii, etc. to stream all TV shows andmovies for playback on living room,

our next concern is: format compatibility of this game console. For playing some incompatible formats like 3GP, FLV,WebM for

web/Chromecast, MOD/TOD/MTS/MXF files recorded by digital camcorders on game consoles smoothly, it is suggested to convert

them to best media formats supported by them.

Then DimoVideo Converter Ultimate can be an all-sided video converter available to convert any SD/HD/4K videos to game consoles

best supported video/audio format onWindows (10/8.1/8/7/XP) in a few clicks as below.

Step 1: Launch DimoVideo Converter Ultimate

First of all you need to launch the DimoVideo Converter Ultimate on your system. There are a number of ways to launch the software

and you can use any convenient method to do so.

Step 2: Add source video files

Click the "Add File" button to browse your folder and add the video files you want to convert to the program.

https://www.mediadimo.com/images/video/samsung-tv-video-settings.png
https://www.mediadimo.com/free-play-game-of-thrones-on-tv.html


Step 3. Select the Output File Format and destination folder

Next task is to select the Output file format and it must be adjusted as per your Game console requirement. Select your model from

"Games". Then click "..." to browse your computer for a better destination folder for game console video converter to save your

converted movies.

Tips: The default setting works well. Of course, if you want to customize video and audio encoding settings, just click the "Settings"

button to customize these settings. You can adjust the output video/audio resolution, frame rate, bit rate, etc. to customize the output

files to get the best quality you want.

https://www.mediadimo.com/images/video/dimo-windows.png
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Step 4: Start conversion

Once you've selected the output file format you want, you're ready to hit the convert option and within few seconds you new customized

video will be available on your preferred folder. Wait for the conversion to be done and click Open to get the converted video files. Now

start to stream converted files to Xbox 360, Xbox One (S), PS3, PS4 (Pro), PS Vita, PSP,Wii, etc. flawless and easily watch the high

definition movie on your TV via DLNA server.

Convert to VR headsets

Converting your ordinary video that are downloaded from Internet into 3D/VR video is muchmore fun than it sounds! And it is possible

to do this job for VR headset like Gear VR, HTCVive, Oculus Rift, etc. with their friendly format within minutes using Dimo Video

Converter Ultimate. Please follow the steps below to understand how to convert any video file to customized formats for VR headsets:

Step 1: Launch DimoVideo Converter Ultimate

The first step is to launch Dimo Video Converter Ultimate by double clicking the installation file.

Step 2: Load the desired video file

The next step is to load the desired video file. You can drag & drop the files or use the "Add File" option to open the file explorer.

https://www.mediadimo.com/images/video/ps4-pro-video-settings.png
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Step 3: Set 3Dmode

If you are thinking to create 3D effect for VR glasses or design a customized vide, then Dimo Video Converter Ultimate can assist you

better with its advanced video editing tools. You simply need to click on the "Edit" button and a new windowwith all tools available for

editing will soon appear. This software provides Side-by-Side outputs, Top bottom and Anaglyph 3Dmode for you to choose from "3D"

tab. Perform required actions and save the video by hitting OK button.

Step 4: Choose the output format from "VR" category

Once you have loaded the file in Dimo Video Converter Ultimate, you need to choose the relevant output format. To convert a video file

to VR headsets, choose your device type from options from the "VR" tab under the "Select Format" tab. There are a number of VR

headsets available like Gear VR, HTCVive, Oculus Rift, PSVR, etc.
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Tip: If you like, you can go to "Settings" page to adjust the parameters including video size, bitrate, frame rate

Step 5: Specify the output folder

Once you have specified the output format, you can also change the default output folder for the resultant file.

Step 5: Start converting the video to VR headsets

Once you havemade all the settings, the final step is to actually convert the loaded video into 3Dor VR videos. Click on the "Start" button

to start the conversion process. Once the conversion process is complete, the resultant video file is a 3D video file for transferring to

Gear VR, HTC Vive, Oculus Rift, PSVR, etc. for watching.

Convert to GIF
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Step 1. Load Video Files

Click on the "Add File" icon on the top bar of the software, or directly drag and drop videos/audios to the program. You can addmultiple

files by clicking "Add File > AddMulti-files" or "Add File > Add Folder".

Note: You could playback loadedmedia files by clicking with the built-in player.

Step 2. Editing the video

Click "Edit" to activate build-in video editor, then go to "Trim" to simply select the start and end times in the progressing bar bymoving

the points and click "+" to cut the video and press "OK".

Tip 1: If you think the video containting the embrassing background, then you could click "Adjust" > "Crop" to locate your specific portion

of your video in output .gif file.

Tip 2: Click "Effect", you can apply some color effects like de-interace etc; And "Watermark" to input text you like to show;
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Step 3. Choose Output GIF Format

Open the drop-down box right and then click the "Select Format " bar to enter the "Profile" panel, where you could select a proper profile

as output format. You could select "GIF" from "Format > Video".

Or make use of the profile search bar to search desired profile quickly.

Step 4. Set Video and Audio Parameters
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You could hit the setting gear icon to enter the "Profile Settings" interface to adjust video and audio parameters of selected output

profile, including: Video Codec, Quality, Video Size, Bit Rate, Frame Rate, Aspect Ratio as well as Audio Codec, Quality, Bit Rate, Sample

Rate, Channels, etc.

Tip: Here you can optimize the frame rate because your computer may not be able to run everything smoothly at a higher frame rate.

Most videos are shot at either 30 or 60 fps, but GIFs are meant to be quicker, smaller, and a little jerky looking. The basic principle here is

that, the smaller the framerate, the faster the GIF will take to play and load. 10-15 FPS is usually perfect.

Step 5. Start making GIF from video

Set a directory to save the output video/audio files by clicking "...". Then Click on "Start" button to start converting video files to GIF

within this video converter software. Now your created .gif file from video is ready to be used for uploading to Instagram, Imgur, Minus,

Dropbox, or any other file hosting service you prefer, or social media posts etc.

Edit Video

TrimVideo

Want to trim out a funny part of a YouTube video? Or just cut out the shaky or useless parts of a camcorder video to save space on your

hard drive?With DimoVideo Converter Ultimate, you can easily trim video to get your desired parts by following the steps below.

Step 1: Launch DimoVideo Converter Ultimate.

First install and launch DimoVideo Converter Ultimate on your computer.

Step 2: Import source file to the program. It is pretty easily to load files with Dimo Video Converter Ultimate, you can directly drag and

drop the files to the program or use the "Add File" button to load source file.

Step 3: Click the "Edit" option to open "Video Editor" window.

After the files are successfully loaded in the program, hit the "Edit" icon to open a new video editing window.

Step 4: Trim video to get desired parts.
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In the opened video editing window, click the "Trim" tab, under the trim tab, drag the slider bar on the "start" line to set the start

trimming point, move the slider bar on the "end" line to set the ending time point, then click "Add TrimMarker" button to add this

segment for trimming.

If you need to trim multiple segments, choose another trim start time and end time, then use "Add TrimMarker" button again. You can

modify the start time and the end time according. If any point of time, you are not happy with the trimming, you can use the delete button

and set the trimming start point again. If you like to put these trimming segments in right order, click "Up" or "Down" button to do

adjustment. To add this multiple trimming segments into one file, check "Merge" option, otherwise you will get splitted trimming files.

Step 5: Define output file format.

On the main interface, click "Select Format" section on the right panel, in the pop out window, select your desired output format for the

trimmed video.

Step 6: Choose output folder.

Specify a destination folder on your computer to save the trimmed videos. You can also choose to skip this step if you want to save the

generated file in the default location.
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Step 7: Start the conversion process.

Click on the "Start" button to start the video conversion process, it will take a fewminutes (depending on file size) for the conversion to

complete.

Vignette Video

Perhaps, you never thought that you can vignette a video on your own. But, now you can easily vignette a video using DimoVideo

Converter Ultimate by following the steps below:

Step 1: Launch DimoVideo Converter Ultimate

Simply launch DimoVideo Converter Ultimate by double clicking the installation file.

Step 2: Load source video

Once you have launched the software, just drag and drop the video to the interface of Dimo Video Converter Ultimate or you can load a

video file by clicking on "Add File" button. Then an explorer will be opened from where you can easily choose the desired video file and

load it.

Step 3: Click on "Edit" button

To vignette a video, you should start editing the video file. To edit the loaded video file, click on the "Edit" button at the bottom of the

output box. Clicking on edit button will open a new editing window.

Step 4: Click on "Effect" tab

In the new editing window, choose the "Effect" tab which will show you a number of editing options.

Step 5: Choose "Vignette" feature

Pull down the function choices and find the "Vignette" feature. Hit it on.
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Step 6: Choose the output format

You can ignore it if you don't need to change your video format. The next step is to choose the output format of the resultant video. You

can choose the output format from the right pane in the "Select Format" tab. All the formats supported by Dimo Video Converter

Ultimate are available here.

Step 7: Specify the output folder

When you have chosen the output format, you can specify the destination folder for the resultant video file. If you don't specify a folder

here, the resultant video file will be stored at the default location specified by DimoVideo Converter Ultimate.

Step 8: Start to vignette a video

Go back to the UI no matter you changed or didn't change the output format. As soon as you click on the "Start" button, the video

vignette process starts.

Crop Video

If needed, you can use Dimo Video Converter Ultimate to crop your video without any other third party software. Cropping video can

make the video more fit in the screen of your devices so that you can get higher entertainment. Please follow the steps below to crop

your video:

Step 1: Launch DimoVideo Converter Ultimate

The very first step is to launch Dimo Video Converter Ultimate by double clicking the installation file.

Step 2: Load the video file to be croped

Then drag your video to the interface of the software or you can click on the "Add File" button at the top left corner to import the video

you need to crop.
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Step 3: Start to crop video

Click on the "Edit" button to open a new editing window that contains a number of editing features. From the new editing window, click

on the "Adjust" tab to open another array of editing options.

The above four icon are used for flipping the video in various angles and rotate your source files. To make the display effect better fitted,

you can choose "Keep Aspect", "Full Screen", "16:9" or "4:3", then use the "Crop" button to adjust the crop frame. You can click "Apply to

All" to apply this settings to other added videos befor conversion.
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Step 4: Choose the output format

If you want another video format from the video croping process, just choose a new video format from "Select Format" profile. All the

formats supported by Dimo Video Converter Ultimate are listed here.

Step 5: Specify the output folder

Dimo has a default folder to save your generated files. Of you also can change the output folder according to your requirement. Select

your defined output folder. Apparently, the output folder is the one where the resultant converted file will be stored. And you can specify

any other folder according to your wish here.

Step 6: Start to convert

The last step is to perform the actual conversion. Click on the "Start" button to actually start converting the video. The duration of

conversion will be highly dependent on the size of the video file needing to be crop.

Change Video Parameters
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Step 1: Click "Add File" button (or simply drag & drop) to load the video you want to change. Or click the "Add File", and from the sublist,

click "AddMulti-files" or "Add Folder" to addmultiple videos. To import your Blu-ray/DVDmovie, please click "Add Blu-ray" or "Add

DVD".

Step 2: Click Edit button on the main interface, then tap the "Adjust" button. Many options will appear, including Contrast, Saturation,

Brightness, etc. You can check to activate to adjusting function and directly drag the progress bar to get the effect you need. And you can

preview the original andmodified video in the preview area in real time.

In addition, you can also trim, crop, split videos, add special effect/text watermark to your video, create 3D, etc. It supports real time

editing when adding text watermark now.

Step 3: Select the output file location, format and set the necessary parameters (frame rate, codec, video size, etc).

Step 4: Click the "Start" button to start improving your videos. As soon as the conversion is 100%done, simply click "Open" or "Open

Folder" button to find brightened videos. Just play and share.
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Deinterlace Video

You can deinterlace a interlaced video by yourself only if you have a professional tool like Dimo Video Converter Ultimate. Please follow

the steps below to quickly deinterlace any video:

Step 1: Launch DimoVideo Converter Ultimate

Double click Dimo Video Converter Ultimate icon to launch the program.

Step 2: Import the desired video file

When you have launched the software, click "Add File" button to open a file explorer from where you can choose the interlaced video.

You also can simply drag and drop the video files to the interface of Dimo Video Converter Ultimate.

Step 3: Hit on "Edit" button

Click on the "Edit" button under the output box to pop up a new window to start editing the video.

Step 4: Choose "Deinterlace" function

In the window of edit, here has several choices. Choose "Effect" icon. There are many video effecting choices. Look for "Deinterlace"

function in the first-line function choices. Click the image and then just close the window.
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Step 5: Select the output format

If you just want to deinterlace a video, you can ignore the step unless you want to convert the video format, as well. When you go back to

the UI, just click "Select Format"in the right pane on the interface. Here, Dimo offers you plenty of video and device preset. Just choose

the one you want.

Step 6: Specify the output folder

After choosing the output format, the next step is to choose an output folder for the resultant file. The default folder is chosen by Dimo

Video Converter Ultimate which can be changed according to your need.

Step 7: Start to deinterlace video

When all the settings are done, the last step is to hit the "Start" button in the middle of the interface.

Add TextWatermark

Adding text watermark to a video tomark the video belonging to you. DimoVideo Converter Ultimate can help you apply a text

watermark to the video easily and quickly without any video quality loss. Please follow the steps below to add text watermark to any

video:

Step 1: Launch theDimo Video Converter Ultimate

Download, install and open Dimo Video Converter Ultimate by double clicking the installation file.

Step 2: Load source video

The following step is to load the video files which you want to add text watermark to. You can load the video file into DimoVideo

Converter Ultimate by either dragging the file in the interface or by clicking on the "Add File" button.When you click on the "Add File"

button, it will open a file explorer from where you can choose the video file you want to import into the software.
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Step 3: Click on "Edit" button to start editing

Select the "Edit" button option under the output box. Once you click on the edit button, a new windowwill pop up containing a number of

features available.

Step 4: Click on "Watermark" tab to add text watermark

In the video editing window, click "Watermark" icon under the video screen where you can add a textual watermark. Just tap the text

what youwant to add into the video in the right place. You can choose font size and and adjust the horizontal and vertical position of the

text watermark. After all the settings, click "Apply".
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Step 5: Choose the output format

You can ignore the step unless you would like to change the original video format. Go back to the UI, in the right pane, find the "Select

Format" section. DimoVideo Converter Ultimate offers a number of video, audio and device format. Choose any one you want.

Step 6: Specify the output folder

Generally, Dimo Video Converter Ultimate is output folder set. But you can change the default location to choose a new folder to store

your generated files with text watermark.

Step 7: Start the conversion process

When you havemade all the settings, the last step is to actually start the conversion process by clicking on the "Start" button.

Apply 3D Effect

You can apply 3D effect like "Red-Blue, Left-Right, Top-Bottom" in the 3D tab to make 2D/3D to 3Dmovie conversion.

Step 1. Load movies
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Launch the top 3D video converter, add your movie files by clicking the "Add File" icon.

Step 2. Select output format

Click "Select Format" bar and find "Format > Video", there are a lot of format options for you. Here MP4 is recommended for most 3D

players, 3D devices, VR headsets. The new profiles for VR headsets like HTCVive, Gear VR, Oculus Rift, PS VR are ready for you.

Step 3. Advanced Video/Audio settings

Click "Settings" button to do corresponding settings regarding to video, audio.

Step 4. Add 3D effect

Click "Edit" icon, turn to "3D" tab, and choose Left-Right option to add side-by-side effect to your 3Dmovies. Or you can start editing

your 3D files by trimming, cropping, rotating, adding text watermark, applying special effect, adjusting saturation/brightness/contrast,

and so on.
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Step 5. Start to convert movies to 3D

The last step is to press the "Start" button on the right to start converting movies to 3D vidoes. The conversion takes a fewminutes, after

conversion, you can click "Open" to locate the output videos for transferring.

Apart from the above editing functions, you can take snapshot of your favourite videos as .jpg file to save the shinning moment for

reviewing.

Make ISO

DimoVideo Converter Ultimate allows the users to make ISO from the video folder or Blu-ray directly. Please follow the steps below to

create ISO using DimoVideo Converter Ultimate:

Step 1: Launch Dimo and add files

Launch DimoVideo Converter Ultimate and click "Make ISO" to locate your source video folder.
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Step 2: Start making ISO

Click on the "Start" button to start the Blu-ray to ISO backing up or video to ISO converting process. It will take a fewminutes to

complete the process.

Compress Video

Your portable devices can't hold so many movies for your viewing at a time unless you compress the video to smaller size.With Dimo

Video Converter Ultimate, you can easily compress 4K 2160p/1080p video:

Step 1: Launch DimoVideo Converter Ultimate

Double click on Dimo Video Converter Ultimate icon on PC to launch the software.

Step 2: Load Source Video

After opened Dimo Video Converter Ultimate, you need to import your source video to the app. You can simply drag and drop the desired

video file to the interface of the application or choose the "Add File" button to open up a file explorer to allow you to select the desired

video file to load. And if you are trying to load the video file from DVD/Blu-ray, then "Add DVD" or "Add Blu-ray" option must be used.
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Step 3: Choose Output Format

You can change your source video format by choosing another output video format. Find "Select Format" function on the right of the

interface to choose any output format offered by DimoVideo Converter Ultimate.

Step 4: Compress Video Size

Generally, to compress a video size, you can downscale its resolution or decrease video bitrate. After you chose output format, you can

hit on "Settings" to open a newwindow. Here, you can reset video size and bitrate to decrease the original file size.
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Note: After settings, you can look at the file size the converter estimates for you. And if it gets over your requirement, lower the video

quality setting: Bitrate and Sizewhich greatly decide the output file size.

Step 5: Specify the output folder

By default, DimoVideo Converter Ultimate allots certain folder for saving all the generated files. Of course, you are allowed to reset the

output folder.

Step 6: Start to compress video

When all the settings are done, you can start the video compression process by clicking on the "Start" button located at the middle of the

screen.
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Play Video

DimoVideo Converter Ultimate can enable you to play any video files stored on your computer no matter what video format and codec

the video is. Please follow the steps below to play videos through DimoVideo Converter Ultimate:

Step 1: Launch DimoVideo Converter Ultimate

Download and install DimoVideo Converter Ultimate. Then launch DimoVideo Converter Ultimate by double clicking the installation

file.

Step 2: Load Source Video

When you launch the Dimo Video Converter Ultimate, the "Converter" tab is already selected by default. You can load the video file by

dragging it into the interface. Or you can click on "Add File" button and open the file explorer. Then you can select the desired video file

from the explorer quickly.

Step 3: Start to Play Video

After you loaded the video into DimoVideo Converter Ultimate, you can see the movie list on the interface. Move the mouse on the video

file you want to play and click it, a media player will pop up and you can play your video now.
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Cast Video toDevices/TVs

DimoVideo Converter Ultimate has a outstanding advantage. That is you can cast the converted video to your iPhone, iPad, Android

Tablet/Phone, TV by the "Media Server" feature offered by DimoVideo Converter Ultimate.

Step 1: Keep your device and PC in same network

Firstly, you need to keep your portable devices and the PC running the software on in the same network.

Step 2: Open Dimo Video Converter Ultimate

The second step is to launch DimoVideo Converter Ultimate.

Step 3: Choose "Media Server" and locate source files

Click on "Media Server" icon at the top of the interface and choose the source folder to locate by pressing "Browse...". Then hit “Share”.

Your IP and Port will be detected automatically, and you will get a QR code.
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Step 4: Scan the resulted OR code for sharing

Use your iPhone, iPad, Android phone/tablet to scan the QR code then you can play the video directly by clicking it from the playlist

without needing to transfer the media to devices via USB. For TV users, you can write http://IP:PORT like "http://192.168.1.109:8868/"

(without quotation marks) to the address bar of your browser for sharing your media files.

The loaded video source will be listed and you can now play local files or converted movies on mobile devices or TV at your will.

https://www.mediadimo.com/wp-content/uploads/site/software/screenshot/1488884157593229540.jpeg
https://www.mediadimo.com/mirror-videos.html
https://www.mediadimo.com/wp-content/uploads/2016/09/gameofthrones-media-server.png

	Guide Index
	Part 1: Trial Version vs. Full Version
	Part 2: User-interface

	Download
	Download online movies
	Convert
	Rip Blu-ray/DVD
	Convert Recorded/Downloaded Video
	Convert to SD/HD/4K videos
	Convert to Audio
	Convert to Web Video
	Convert to Editors
	Convert to Multi-track
	Convert to Apple/Samsung/LG/Android
	Convert to TVs
	Convert to Game Consoles
	Convert to VR headsets
	Convert to GIF

	Edit Video
	Trim Video
	Vignette Video
	Crop Video
	Change Video Parameters
	Deinterlace Video
	Add Text Watermark
	Apply 3D Effect
	Make ISO
	Compress Video
	Play Video
	Cast Video to Devices/TVs


